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1 Einleitung
Diese Anleitung beschreibt die Installation, die Konfiguration und die Nutzung des

Zahlungsmoduls für JTL und DocData.

Bevor Sie mit der Installation beginnen können, stellen Sie sicher, dass Sie im Besitz aller

notwendigen Daten sind. Sie benötigen:

DocData Merchant Name

DocData Merchant Passweord

JTL Zahlungsmodul von sellxed.com/shop

Zugangsdaten zu Ihrem Server und Shop

Beachten Sie, dass Sie für unsere Plugins mindestens die PHP Version 5.6 verwenden müssen.

PHP 8 oder höher wird derzeit nicht unterstützt.

1.1 Ablauf der Installation

In diesem Dokument erhalten Sie alle Informationen, die für die Installation des Moduls

notwendig sind. Für die Inbetriebnahme des Moduls sollten Sie die einzelnen Punkte der

Checkliste strikt befolgen. Nur so kann ein sicherer Einsatz in Übereinstimmung mit allen

Sicherheitsregularien gewährleistet werden.
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Konfiguration der DocData Einstellungen

Konfiguration des Hauptmoduls

Konfiguration der akzeptierten  inkl. AutorisationsmethodenZahlungsarten

Durchführung einer Testbestellung

Aktivierung Ihres Kontos bei DocData

Installationsservice

Unsere Zahlungsmodule sind standardmässig so vorkonfiguriert, dass die Installation

gleich nach dem Eintragen der benötigten Keys funktionieren sollte. Sollten Sie einen

Setting aus der Konfiguration des Moduls nicht kennen, können Sie sich gerne mit

unserem Support in Verbindung setzen.

Unser Support Team steht Ihnen während der Geschäftszeiten gerne zur Verfügung: 

. Sie haben zudem jederzeit die Möglichkeit unserenhttp://www.sellxed.com/support

Installationsservice zu bestellen. Wir sorgen für eine reibungslose Installation in Ihrem

Shop: http://www.sellxed.com/shop/de/integration-und-installation.html

.htaccess Verzeichnisschutz

Für den Test des Zahlungsmoduls muss jeglicher Verzeichnisschutz oder IP Sperre auf

Ihrem Server zwingend ausgeschaltet sein, sonst kann es sein, dass das

Zahlungsfeedback von DocData nicht bis zu Ihrem Shop durchdringt.

1.2 System Anforderungen

Generell hat das Plugin die gleichen Anforderungen an das System wie JTL selber. Nachfolgend 

finden Sie die wichtigsten Anforderungen des Plugins:

PHP Version: 5.4.x oder höher

OpenSSL: Aktuelle Version mit Unterstützung von TLS 1.2 oder höher.

fsockopen: Die PHP Funktion fsockopen muss zur Verfügung stehen. Das Plugin muss 

Verbindungen zu anderen Servern öffnen können.

PHP Funktionen: Im weiteren müssen alle gängigen PHP Funktionen zur Verfügung stehen.

http://www.sellxed.com/support
http://www.sellxed.com/shop/de/integration-und-installation.html
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2 Konfiguration DocData - Backend
Eine Übersicht über die Transaktionen und Einstellungen finden Sie im Backend von DocData:

Test Umgebung: https://test.docdatapayments.com/ps/com.tripledeal.

paymentservice.backoffice.Login

Live Umgebung: https://backoffice.docdatapayments.com/ps/com.tripledeal.

paymentservice.backoffice.Login

2.1 Konfiguration des Hauptmoduls

Tragen Sie in der  den Merchant name und das MerchantHauptkonfiguration des Moduls

Passwort ein. Sie können hier zudem noch ein Default CSS wählen. Das Default CSS entspricht der

von Ihnen hinterlegten Standard CSS Konfiguration in DocData. Sie können dieses Settings in der 

 überschreiben.Konfiguration der Zahlungsart

Wählen Sie zudem, ob Sie die Zahlungen im Live oder Test Mode abwickeln wollen.

2.2 Konfiguration der Zahlungsarten

Sie können jeweils für jede Zahlungsart dedizierte Einstellungen vornmen.

Bitte beachten Sie, für die Zahlart Banktransfer und Open Invoice (Klarna und Afterpay) müssen

Sie bei DocData das Feature extendedStatusRequests auf Ihrem Account aktivieren lassen.

2.2.1 CSS ID

Definieren Sie für jede Zahlart Ihre CSS ID, welche Sie bereits im Backend von DocData gesetzt

haben. Sie können CSS Profile unter  definieren.Settings > Edit Look and Feel

https://test.docdatapayments.com/ps/com.tripledeal.paymentservice.backoffice.Login  
https://test.docdatapayments.com/ps/com.tripledeal.paymentservice.backoffice.Login  
https://backoffice.docdatapayments.com/ps/com.tripledeal.paymentservice.backoffice.Login  
https://backoffice.docdatapayments.com/ps/com.tripledeal.paymentservice.backoffice.Login  
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Abbildung 2.1: Anlegen von CSS Profilen unter Settings > Edit Look and Feel.

2.2.2 Payment Profile

Mit dem Payment Profile können Sie die Vorselektierung einer Zahlart auf der Payment Page

einrichten. Dafür müssen Sie für jede Zahlart ein Payment Profile im Backend von DocData

anlegen.

Unter  können Sie profile anlegen und den ProfileEdit > Payment method and names

Zahlungsweisen zuordnen. Den Namen des Profils tragen Sie dann in der Konfiguration der

Zahlart ein. Dies führt dazu, dass bereits diese Zahlart vorselektiert angezeigt wird.
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Abbildung 2.1: Erstellen von Payment Profilen zur Zahlungsart Selektion unter Edit > Payment 

method and names.

Weitere Informationen zu den Konfiguration der Zahlungsarten und der Bedeutung der einzelnen

Einstellungen finden Sie .hier

2.3 Aktivieren des Cron Jobs

Da DocData keine Notifikationsantworten sendet, kann es sein, dass der Kunde das Fenster vor

Abschluss der Zahlung schliesst. In diesem Fall empfehlen wir Ihnen das Einrichten von Cron Jobs

in Ihrem Shop. Weitere Informationen hierzu finden Sie im Kapitel Cron Job

2.4 Testen und aktivieren des Moduls

Nach Aktivierung und der Konfiguration der Zahlungsarten führen Sie einen Test mittels der

publizierten  in der Anleitung durch. Sofern alle Tests erfolgreich verlaufen Sind,Testdaten

schalten Sie im Hauptmodul den Betriebsmode auf Live
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3 Modul Installation im JTL Shop

3.1 Installation

Sie sollten zu diesem Zeitpunkt bereits im Besitz des Moduls sein. Falls nicht erhalten Sie die

Moduldateien in Ihrem Benutzerkonto im  (Menüpunkt "Meine Downloadartikel"). Umsellxed Shop

das Modul in Ihrem JTL Shop zu installieren, führen Sie bitte folgende Schritte durch:

Laden Sie das Plugin herunter. Den Download finden Sie in Ihrem sellxed.com Account 

unter "Meine Downloadartikel".

Entpacken Sie das Archive, welches Sie heruntergeladen haben.

Im entpackten Ordner finden Sie einen Ordner "files"

Für einige Shops werden verschiedene Versionen des Plugins zur Verfügung gestellt.

Laden Sie nun mit Ihrem preferierten FTP Programm  dieses Ordners ins den ganzen Inhalt

Stammverzeichnis Ihres Shops. Bei gewissen Shops gibt es einen spezifischen Ordner, 

welcher die Plugins enthält. Sollte dies der Fall sein laden Sie das Plugin in diesen Ordner 

hoch. Stellen Sie sicher, dass die Ordner nur zusammengeführt werden und nicht ersetzt.

Falls nicht bereits geschehen, loggen Sie sich bitte in Ihrem Shop ein.

3.2 Updates und Upgrades

Während der Supportdauer, erhalten Sie unbeschränkten Zugriff auf Updates und Upgrades in

Ihrem Kundenkonto. Um über solche Updates informiert zu werden abonnieren Sie bitte den RSS-

Feed. Mehr Informationen hierzu finden Sie hier: .http://www.sellxed.com/de/updates_upgrades

3.2.1 Update Checklist

Bitte führen Sie vor jedem Update folgende Schritte durch:

https://www.sellxed.com/shop/de/customer/account/login/
http://www.sellxed.com/de/updates_upgrades
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Erstellen Sie immer ein Backup der Files und der Datenbank, bevor Sie mit dem Update 

beginnen

Testen Sie das Update auf einem . Wir testen die Module intern, es kann aber Testsystem

sein, dass im Zusammenspiel mit anderen Plugins weitere Fehler auftreten.

Warten Sie bis die Files vollständig auf den Server gespielt sind und besuchen Sie dann die 

Konfigurationsseite des Hauptmoduls. Falls vorhanden leeren Sie bitte auch noch alle 

Caches des Shopssystems

Je nach Update kann es sein, dass eine Datenbankmigration durchgeführt werden muss. Wir

empfehlen Ihnen daher, dass Update zu einem Zeitpunkt durchzuführen, an dem nicht zu viele

Kunden auf Ihrem Shop zugreifen.

Vorsicht bei Updates im Live Shop

Besondere Vorsicht ist bei Updates im Live Shop geboten. Testen Sie ein Update immer

zuerst in einem Testsystem. Unser Support Team hilft Ihnen gerne bei Problemen. Bei

Updates direkt im Live-System kann es jedoch zu unterbrüchen kommen, welche je nach

Support Ressourcen bis zu 2 Tage dauern können.

3.2.2 Update Instruktionen

Bevor Sie das Update aufspielen, lesen Sie bitte die Update Instruktionen. Diese finden sich am

Ende der Pluginseite im Changelog. Sofern nichts weiteres in den Update Instruktionen steht,

können die Files einfach überschrieben werden.



 / 12 26

4 Modul Konfiguration im JTL Shop
Die Konfiguration teilt sich in zwei Stufen. Der erste Schritt umfasst die Konfiguration des

Hauptmoduls mit den Grundeinstellungen (vgl. . In einemKonfiguration des Hauptmoduls)

zweiten Schritt können für jede individuelle Konfigurationen vorgenommen werden.Zahlungsart 

Dies bringt Ihnen volle Flexibilität und grösste Anpassung an Ihre Prozesse.

Erstellen Sie Backups!

Bitte erstellen Sie auf jeden Fall ein Backup des Hauptverzeichnises Ihres Shops. Bei

Problemen können Sie so jederzeit wieder zum Ursprungszustand zurückkehren.

Im Weiteren empfehlen wir Ihnen die Integration zuerst auf einem Testsystem

durchzuführen. Es kann immer wieder zu Komplikationen mit von Ihnen installierten

Drittmodulen kommen. Bei Fragen steht Ihnen unser kompetenter Support gerne zur

Verfügung.

4.1 Konfiguration des Hauptmoduls

In einem ersten Schritt muss das Plugin installiert werden. Die Installation der Plugins erfolgt wie

gewohnt unter: Mit dem Klick auf  wird dasPlugins > Pluginverwaltung > DocData . Installieren

Plugin im Shop installiert. Sie finden die Einstellungen des Hauptmoduls unter Plugins > DocData

.

Sie finden die Einstellungen des Hauptmoduls unter . Um das Plugin zuPlugins > DocData 

konfigurieren, wechseln Sie in den Tab . Tragen Sie hier die bereits im BackofficeKonfigurationen

von DocData vorgenommenen Einstellungen ein. Bei Unklarheiten finden Sie zudem zu jeder

Option weitere Informationen und Erläuterungen indem Sie mit dem Cursor über das

Fragezeichen fahren.

Im Tab  finden Sie zudem wichtige Informationen zu Ihrem Plugin wie dieInformationen

Versionsnummer, Release Datum und Rücksprung URL. Diese Daten sind im Falle von Problemen

wenn möglich immer unserem Support anzugeben.

Wenn Sie das wünschen synchronisiert das Zahlungsmodul die Bestellstatus mit den

Transaktionen bei DocData. D.h. Wenn Sie einen Artikel als versendet oder storniert markieren

haben Sie die Möglichkeit die Zahlung automatisch auch bei DocData zu verbuchen. Weitere

Informationen hierzu finden Sie im Punkt .Das Modul in Aktion

4.2 Konfiguration der Zahlungsart

4.2.1 Installation der Zahlungsarten im Shop

Nachdem das Hautpmodul erfolgreich konfiguriert wurde, finden Sie unter Kaufabwicklung >

die Einstellungen zu den einzelnen Zahlungsarten in Ihrem Shop. JedeZahlungsarten 
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Zahlungsart wird Ihnen einzeln aufgelistet. Installieren Sie jene Zahlungsmethoden, welche Sie

Ihren Kunden anbieten möchten. Sie können für jede Zahlungsart individuelle Einstellungen

vornehmen und so die Zahlung optimal an Ihre Prozesse anpassen. Die zentralen Optionen

werden in der Folge genauer erläutert.

Damit die Zahlungsart im Shop auch sichtbar für Ihre Kunden wird muss diese zudem noch mit

der Versandart verknüpft werden. Öffnen Sie die Versandarten unter: Kaufabwicklung >

. Mit dem klick auf  können Sie die Versandarten anpassen. Hier definierenVersandarten ändern

Sie die gewünschten Zahlungsgebühren für jede Zahlungsart. Mit einem Häckchen können Sie

die Zahlungsart mit der Versandart verknüpfen.

4.2.2 Konfiguration der Zahlungsart in der WaWi

Damit die Zahlungsart im Shop auch in der WaWi richtig verknüft wird, müssen Sie diese

hinzufügen (Einstellungen > Zahlungsarten verwalten). Achten Sie darauf, dass die Zahlungsart

genau gleich geschrieben wird, wie im Feld Anmerkung. Wenn also dort Kreditkarte Steht, tragen

Sie als Name Kreditkarte ein.

4.3 Direktes Verbuchen von Bestellungen

Mit der Option "Buchung" legen Sie fest, ob Zahlungen direkt verbucht, oder zuerst autorisiert

werden. Sofern Sie in einem ersten Schritt nur autorisieren möchten, stellen Sie sicher, dass die

Zahlungen später verbucht werden.

Eine Reservation ist, abhängig von Ihrem Acquiring Vertrag, nur eine gewisse Zeit garantiert.

Sollten Sie in dieser Zeit nicht verbuchen, kann es sein, dass die Autorisierung nicht mehr

garantiert wird. Weitere Informationen zum Prozess der Verbuchung finden Sie weiter unten.

Unterschiedliche Einstellungen zwischen DocData - Backend und 
Modul

Es kann sein, dass die Einstellungen im Modul für die Zahlungsweise Ihre Einstellungen

im Backend von DocData einfach überschreiben.

4.4 Unsicherer Status

Sie können Bestellungen, für welche die Zahlung noch nicht garantiert werden kann, speziell

markieren. Dies erlaubt Ihnen diese Bestellung vor dem Versand noch einmal manuell zu prüfen.

4.4.1 Setzen von Order-Status

Sie können für jede Zahlungsart festlegen in welchen Status die Bestellung je nach

Buchungsstatus verschoben werden soll. Es handelt sich hier um den initialen Status der

Bestellung.
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4.5 Optional: Validierung

Mit der Validierung steuern Sie den Zeitpunkt wann eine Zahlungsart im Checkout angezeigt

werden soll. Diese Einstellung ist für Module relevant bei denen die Benutzung von

Voraussetzungen Ihres Kunden abhängig ist. Beispielsweise wenn noch eine Bonitätsprüfung

erfolgen soll, oder die Zahlungsart nur in gewissen Ländern verfügbar ist. Es kann sein, dass

diese Einstellung bei Ihnen nicht ersichtlich ist. Dann überspringen Sie diesen Punkt. Damit die

Bonitätsprüfung beziehungsweise Adressvalidierung auch mit europäischen Zeichen

funktioniert, muss bei gewissen PSP-Einstellungen das Charset des "Blowfish mode" auf "UTF-8"

gesetzt werden.

Sollte die Einstellung ersichtlich sein, haben Sie die Wahl zwischen folgenden Optionen:

Validierung vor Auswahl der Zahlungsmethode: Es erfolgt vor der Auswahl der Methode 

eine Validierungsprüfung. Sofern die Voraussetzungen nicht erfüllt sind, wird die 

Zahlungsart nicht angezeigt.

Validierung nach der Auswahl der Zahlungsmethode: Die Prüfung der Voraussetzung 

erfolgt nach der Wahl und vor der Bestätigung der Bestellung.

Während der Autorisierung: Die Validierungsprüfung erfolgt durch DocData während dem 

Autorisierungsprozess. Die Zahlungsmethode wird auf jeden Fall angezeigt.
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5 Einstellungen / Konfiguration von 
Zahlungsarten

5.1 Allgemeine Informationen zu den Zahlungsarten

Das Plugin wird mit einer grossen Auswahl von Zahlungsarten ausgeliefert. Sollte eine

Zahlungsart nicht verfügbar sein, bitten wir Sie sich mit uns in Verbindung zu setzen.

Für die Nutzung einer Zahlungsmethode muss die Zahlungsart in Ihrem Konto bei DocData und

im Shop aktiviert sein. Informationen zur Konfiguration des Zahlungsmoduls finden Sie weiter

oben.

In den folgenden Punkten finden Sie wichtige Informationen zu bestimmten Zahlungsarten, die

sich vom Standard unterscheiden.

5.2 Informationen zum Zahlungszustand

Sie können für jede Zahlungsart den initialen Zahlungsstatus individuell definieren (Status für

autorisierte Zahlungen etc). Dabei definieren Sie den Zahlungsstatus für die einzelnen Zustände

abhängig von der Verarbeitungsart der Bestellung (verbucht, autorisiert, etc.). Es handelt sich

dabei um den initialen Status, welcher die Bestellung annimmt. Abhängig von der durch Sie

durchgeführten Mutationen kann sich der Status ändern.

Wichtige Info bezüglich dem Bestellstatus

Setzen Sie den Status nie auf  oder einen ähnlich lautenden pendingPending DocData

status, der durch das Modul eingeführt wird.

5.2.1 Bestellstatus "ausstehend" / bevorstehende Zahlung (oder ähnlich)

Bestellungen mit dem Status 'pending DocData' sind pendente Bestellungen. Der Status wird

gesetzt, wenn der Kunde für die Zahlung umgeleitet wird aber nicht erfolgreich zurückkehrt oder

das Feedback nicht bis zu Ihrem Shop gekommen ist (Kunde hat das Fenster auf der Payment

Page geschlossen und die Zahlung nicht abgeschlossen). Abhängig von der Zahlungsart werden

diese Bestellungen automatisch in abgebrochene Bestellungen umgewandelt und der

Lagerbestand wieder freigegeben (sofern der Cronjob Aktiviert ist). Diese Zeitspanne hängt von

den Eigenheiten der Zahlungsart ab, und kann nicht konfiguriert werden.

Wenn Sie eine Vielzahl ausstehender Bestellungen haben, deutet dies in der Regel darauf hin,

dass die Notifikationen von Ihrem Webserver zu DocData blockiert werden. In diesem Fall

überprüfen Sie die Einstellungen Ihrer Firewall und bitten den Hoster die IPs und User Agents von

DocData zu aktivieren.
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5.2.2 Abgebrochene / stornierte Bestellungen

Bestellungen, die als abgebrochen markiert werden, wurden wie oben beschrieben automatisch

in diesen Status aufgrund des Timeouts versetzt. Abgebrochen werden aber auch alle

Bestellungen, welche von den Kunden aktiv abgebrochen wurden.
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6 Das Modul in Aktion
In der Folge finden Sie eine Übersicht über die wichtigsten Funktionen im täglichen Gebrauch

des DocData Moduls.

6.1 Nützliche Transaktionsinformationen zur Bestellung

Sie finden in jeder Bestellung, die mit unserem Modul abgewickelt wurde, eine Übersicht über

die wichtigsten Informationen zur Transaktion. Unter anderem erlauben diese Informationen die

eindeutige Zuordnung der Bestellungen zu den Transaktionen, welche Sie bei DocData im

Backend sehen.

Abbildung 6.1: Transaktionsinformationen in JTL Backend

Die Zahlungsinformationen werden auch in Ihren JTL WaWi Client übertragen.

Abbildung 6.1: Transaktionsinformationen in JTL WaWi
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1.  

2.  

6.2 Einpflegen von Zahlungsinformationen eines Verarbeiters

An folgenden Stellen können Sie die Zahlungsinformationen einer "Bestellung auf Rechnung"

einsehen bzw. manuell einbetten.

6.2.1 JTL Bestellbestätigung (E-Mail)

Bitte fügen Sie folgenden Codeblock in Ihr JTL Mailtemplate, sofern Sie die Rechnungsdetails des

Verarbeiters in der Mailbestätigung an den Kunden senden möchten:

HTML Mailtemplate

{if !empty($Bestellung->cwPaymentInformation)}

{$Bestellung->cwPaymentInformation}

{/if}

PLAIN Mailtemplate

{if !empty($Bestellung->cwPaymentInformation)}

{$Bestellung->cwPaymentInformation|replace:"\n"|strip_tags:false}

{/if}

Dies muss für jede Sprache und für Text und HTML eingefügt werden.

6.2.2 JTL Rechnung (PDF)

Aufgrund technischer Einschränkungen ist es momentan nicht möglich die

Zahlungsinformationen hier abzubilden.

6.2.3 JTL-Backend (Transaktionsdetails)

Die Transaktionsdetails können Sie im JTL unter Plugins > Plugins > DocData > Transaktionen

öffnen.

6.2.4 JTL Success-Page

Aufgrund technischer Einschränkungen ist es momentan nicht möglich die

Zahlungsinformationen hier abzubilden.

6.3 Transaktionsmanagement aus dem JTL Shop

Transaktionen können Sie direkt aus Ihrem JTL Shop Backend durchführen.
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6.3.1 Versand

JTL unterstützt nicht direkt einen Bestellzustand. Generell werden die Bestellungen in der WAWI

verarbeitet und dort können entsprechende Zustände gesetzt werden. 

Das Modul erzeugt einen Zahlungseingang, welcher an JTL übertragen wird. In JTL kann dann

basierend auf dem Zahlungseingang der Versand ausgelöst werden.

6.3.2 Verbuchen von Bestellungen

Sie können Bestellungen direkt im Backend verbuchen. Dazu wechseln Sie in das Hauptmodul

und dort in den Tab . Anhand des Filters können Sie nach der BestellnummerTransaktionen

suchen. Beim Klicken auf  finden Sie weitere Informationen zur Transaktion. Wenn SieAnzeigen

nun eine Bestellung verbuchen möchten, klicken Sie auf Verbuchen. Hier können Sie die Beträge

und Artikel anpassen. Mit dem Klick auf  wird das Capturing an DocData übertragen.Buchung

Falls Sie nicht alle Artikel der Bestellung verbuchen wollen, können Sie die Transaktion durch

anklicken des Kästchens auch für spätere Verbuchungen schliessen.

Abbildung 6.1: Verbuchen von Bestellungen im JTL Backend

Partial Capturing

Erkundigen Sie sich, ob mehrere Verbuchungen von DocData in Ihrem Vertrag unterstützt

werden. Sonst kann es vorkommen, dass die Transaktion bei einer Teilverbuchung für

spätere Verbuchungen geschlossen bleibt.

6.3.3 Bestellungen stornieren

Um Transaktionen zu stornieren, öffnen Sie wie oben beschrieben die entsprechende

Transaktion. Mit dem Klick auf erfolgt ein Storno bei DocData. Der reservierte BetragStornieren 

wird auf der Karte Ihres Kunden sofort freigegeben.
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Abbildung 6.1: Stornieren von Bestellungen im JTL Backend

6.4 Gutschriften

Für belastete Transaktionen können Sie auch Gutschriften erstellen und automatisch an

DocData übermitteln. Zu diesem Zweck öffnen Sie die Rechnung einer bereits verbuchten

Bestellung (wie oben beschrieben). Durch den Klick auf  öffnet sich der Dialog fürGutschreiben

die Gutschriften. Passen Sie den Betrag an, den Sie zurückerstatten wollen. Mit dem Klick auf 

 wird die Gutschrift an DocData übermittelt.Rückvergüten

Abbildung 6.1: Gutschriften direkt aus dem JTL Backend

Bitte beachten Sie, dass Sie maximal 100% des ursprünglich gebuchten Betrags rückvergüten

können.

Das Ausführen einer Gutschrift verändert die Bestellung nicht.

6.5 Einrichten Cron Job

Um die zeitgesteuerten Funktionen des Plugins zu aktivieren (bspw. Update Service, Löschen

pendenteter Bestellungen, etc.), richten Sie in Ihrem Hosting einen zeitgesteuerten Request auf

die URL ein, welche Sie unter Plugins > Plugins >DocData im Tab "Erweiterte Informationen"

finden. Der regelmässige Aufruf löst die entsprechenden Aktionen aus.

Wir empfehlen Ihnen hier eine Cron Engine wie beispielsweise . Damit können Sie dieEasyCron

Datei (URL) mit einem externen Service aufrufen

https://www.easycron.com?ref=39190
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7 Testing
Bevor Sie vom Test Modus in den Live Modus wechseln, sollten Sie das Modul ausführlich testen.

Testen

Vergessen Sie nicht, nach erfoglreichem Testing den Betriebsmodus von Test auf Live

umzustellen.

7.1 Testdaten

Nachfolgend finden Sie die Testdaten für die Zahlungsmethoden:

Credit / Debit Card

VISA

Kartennummer 4111 1111 1111 1111

Expiry Date 03/2027

Name Hans Muster

CID 333

3D-Secure ECI = 5

Mastercard

Kartennummer 5100 0000 0000 0008

Expiry Date 03/2027

Name Hans Muster

CID 333

3D-Secure ECI = 2

American Express

Kartennummer 3411 1111 1111 111

Expiry Date 03/2027

Name Hans Muster

CID 2234

Maestro

Kartennummer 6703 0500 0340 17105

Expiry Date 09/2022

Name Hans Muster

CID 333

3D-Secure ECI = 2

Bancontact Mister Cash

Kartennummer 6703 0500 0340 53002

Expiry Date 09/2022

Name Hans Muster

CID 333

MasterCard
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Mastercard

Kartennummer 5100 0000 0000 0008

Expiry Date 03/2027

Name Hans Muster

CID 333

3D-Secure ECI = 2

Mastercard

Maestro

Maestro

Kartennummer 6703 0500 0340 17105

Expiry Date 09/2022

Name Hans Muster

CID 333

3D-Secure ECI = 2

Maestro

Visa

VISA

Kartennummer 4111 1111 1111 1111

Expiry Date 03/2027

Name Hans Muster

CID 333

3D-Secure ECI = 5

VISA

American Express

American Express

Kartennummer 3411 1111 1111 111

Expiry Date 03/2027

Name Hans Muster

CID 2234

American Express

Bancontact

Bancontact Mister Cash

Kartennummer 6703 0500 0340 53002

Expiry Date 09/2022

Name Hans Muster

CID 333

Bancontact Mister Cash
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8 Fehler und deren Lösungen
Sie finden ausführliche Informationen unter . Sollte sich Ihrhttp://www.sellxed.com/de/faq

Problem mit den zur Verfügung gestellten Informationen nicht lösen lassen, melden Sie sich

bitte direkt bei uns: http://www.sellxed.com/de/support

8.1 Der Name der Zahlungsart wird in der Email nicht korrekt 
dargestellt

Je nach Name der Zahlungsart kann es sein, dass aufgrund unserer Namenskonventionen ein

etwas komischer Name der Zahlungsart in der Email steht. Dies können Sie umgehen indem Sie

die Email Vorlagen anpassen. Hierfür navigieren Sie im Adminbereich nach Inhalt > Email

Vorlagen.

Ersetzen Sie hier in der Bestellmail an gewünschter Stelle folgendes '{$Bestellung-

>cZahlungsartName}' durch '{$Bestellung->Zahlungsart->caption}'. Ab sofort wird in dem Email

der in der Konfiguration der Zahlungsart gesetzte Name angezeigt.

8.2 Die Referrer URL erscheint in meinem Analytics Tool

Unter Umständen kann die Referrer URL von DocData fälschlicherweise im Analytics Tool

erscheinen. Dies passiert, wenn der Kunde mit einer HTTP Header Weiterleitung zurück in den

Shop geleitet wird. Die meisten Analytic Tools können dieses Problem jedoch minimieren, indem

die entsprechende URL aus dem Report ausgeschlossen wird.

Für Google Analytics hilft dieses Step-by-Step Guide am Beispiel von PayPal: Weitere Infos sind

unter Punkt 4 beschrieben.

http://www.sellxed.com/de/faq
http://www.sellxed.com/de/support
http://www.optimizesmart.com/tracking-true-referrals-in-google-analytics-when-using-paypal-and-other-payment-gateways/
http://www.optimizesmart.com/tracking-true-referrals-in-google-analytics-when-using-paypal-and-other-payment-gateways/
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9 Kompatibilität zu Third-Party Plugins
Unten aufgeführte Plugins sind kompatibel mit unseren Zahlungsmodulen und erleichtern Ihnen

in gewissen Bereichen die Arbeit.

9.1 Geburtstag und Geschlecht in JTL

Für gewisse Zahlungsanbieter ist es nötig den Geburtstag sowie das Geschlecht des Kunden zu

prüfen. JTL tut dies standartmässig nicht. Diese Abfrage können Sie unter "Einstellungen >

Kunden / Formulare > Anrede abfragen" bzw. "Einstellungen > Kunden / Formulare >

Geburtstagsdatum abfragen".
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10 Error Logging
Das Modul logged verschiedene unerwartete Fehler und sonstige Fehler abhängig vom

konfigurierten Logging Level. Sollte es ein Problem mit dem Modul geben kann das Log Hinweise

auf dessen Ursache liefern.
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11 Erweiterte Informationen
Dieser Abschnitt des Manuals beinhaltet Informationen für Anwender mit speziellen

Anforderungen. Sämtliche hier aufgeführte Informationen und Konfigurationen sind optional

und für die normale Verwendung des Plugins nicht erforderlich.

11.1 Transaction Object

In diesem Abschnitt finden Sie Informationen wie Sie Daten zu einer Transaktion aus der

Datenbank auslesen können um diese, z.B. in einem ERP System, weiter zu verarbeiten.

Für die Code Snippets in diesem Abschnitt wird angenommen, dass sich Ihr Script im

Stammordner des Shops, in einer Standart Ordnerstruktur befindet.

Initialisieren Sie JTL in Ihrem Script, dies ist nötig um die Verbindung zur Datenbank herzustellen.

require_once("includes/globalinclude.php");

Inkludieren Sie die Hauptdatei des Moduls und die Transactions Class.

require_once 'includes/plugins/docdatacw/version/100/init.php';

require_once 'includes/plugins/docdatacw/version/100/classes/DocDataCw

/Entity/Transaction.php';

Nun können Sie die Transaktion laden und das transactionObject extrahieren.

Laden der Transaktion per Id:

$transactionById = DocDataCw_Entity_Transaction::loadById($transactionId);

$transactionObject = $transactionById->getTransactionObject();


	1 Einleitung
	1.1 Ablauf der Installation
	1.2 System Anforderungen

	2 Konfiguration DocData - Backend
	2.1 Konfiguration des Hauptmoduls
	2.2 Konfiguration der Zahlungsarten
	2.2.1 CSS ID
	2.2.2 Payment Profile

	2.3 Aktivieren des Cron Jobs
	2.4 Testen und aktivieren des Moduls

	3 Modul Installation im JTL Shop
	3.1 Installation
	3.2 Updates und Upgrades
	3.2.1 Update Checklist
	3.2.2 Update Instruktionen


	4 Modul Konfiguration im JTL Shop
	4.1 Konfiguration des Hauptmoduls
	4.2 Konfiguration der Zahlungsart
	4.2.1 Installation der Zahlungsarten im Shop
	4.2.2 Konfiguration der Zahlungsart in der WaWi

	4.3 Direktes Verbuchen von Bestellungen
	4.4 Unsicherer Status
	4.4.1 Setzen von Order-Status

	4.5 Optional: Validierung

	5 Einstellungen / Konfiguration von Zahlungsarten
	5.1 Allgemeine Informationen zu den Zahlungsarten
	5.2 Informationen zum Zahlungszustand
	5.2.1 Bestellstatus "ausstehend" / bevorstehende Zahlung (oder  ähnlich)
	5.2.2 Abgebrochene / stornierte Bestellungen


	6 Das Modul in Aktion
	6.1 Nützliche Transaktionsinformationen zur Bestellung
	6.2 Einpflegen von Zahlungsinformationen eines Verarbeiters
	6.2.1 JTL Bestellbestätigung (E-Mail)
	6.2.2 JTL Rechnung (PDF)
	6.2.3 JTL-Backend (Transaktionsdetails)
	6.2.4 JTL Success-Page

	6.3 Transaktionsmanagement aus dem JTL Shop
	6.3.1 Versand
	6.3.2 Verbuchen von Bestellungen
	6.3.3 Bestellungen stornieren

	6.4 Gutschriften
	6.5 Einrichten Cron Job

	7 Testing
	7.1 Testdaten

	8 Fehler und deren Lösungen
	8.1 Der Name der Zahlungsart wird in der Email nicht korrekt dargestellt
	8.2 Die Referrer URL erscheint in meinem Analytics Tool

	9 Kompatibilität zu Third-Party Plugins
	9.1 Geburtstag und Geschlecht in JTL

	10 Error Logging
	11 Erweiterte Informationen
	11.1 Transaction Object


